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Part 1 How To Activate MyPBX
Client Addon

1 Activate MyPBX Client Addon

To activate client Addon, you should provide your MyPBX LAN MAC address. You can find it
on the motherboard or the enclosure of MyPBX.
Here is a screenshot of a MAC address:

(Figure 1-1)

Notes:
1. Client addon is available on MyPBX Enterprise/U100/U200 series only now. MyPBX
U300/U5XX will support client addon in near future.
2. LAN MAC is the key to get license.
Please contact the reseller/dealer from whom you got the MyPBX to purchase activation

license.

Below is the steps to activate the Client addon:
Step 1. Click “Addons” to switch to the Client addon activation page.

www.yeastar.com Page 4
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——
- . A .. Reports . AddoRs | Logout
£ Addons Settings

Global

Note: For usage of the following addon, please purchase activation code from your equipment provider.

Call Recording (Non-installed)

Call Recording enables all your inbound and outbeund phone calls to be recorded. The system would detect all call conversations and record them & st
automatically. The call recordings would be saved in the folder you specify and stored in a USB device

MyPEX Client (Non-instaled)

MyPBX Client is an application coordinated with MyPEX that connects your PC and IP phones. With MyPBX Client, you can perform various operations () Install
g including check extension status, manage contacts, voicemails, and CDR of extension, realize click-to-call and call popup, send instant messages between
extensions, initiate a conference call, and create a call task, etc. Trial

Billing System (Non-installed)

Billing System can charge and recharge extensions and conduct data analysis. Both prepaid and postpaid are supported. Rate can be set according to
extensions, time periods, call duration, prefix number and number length. Real-ime recharging history, call logs, and statistic are recorded. (4 Instal
WARNING: If Billing System is enabled, DISA and Callback functions would be disabled.

(Figure 1-2)
Step 2. Click “Install” and enter the activation code you purchased, then click “Active”.

Install MyPBX Client

MAC: f4b545060134

Client Number: 30

Active Code: REYETR-CEFGF8D2D24F4FAQANCAIC16666F1F12E

o Active | | g€ Cancel

(Figure 1-3)
Step 3. After you click “Active”, MyPBX will pop up a reboot tag. Click “Reboot now”, the
activation will take effect permanently after the MyPBX reboots.

Notes:

1. Activation is permanent in MyPBX even if you make a factory reset on MyPBX. If you
want to change the number of client, you should enter the activation code again and
confirm the number of client.
By default, MyPBX can support 2 clients even if you don’t activate it.
When you purchase activation code, you can ask for another developer, which is
“yea” by default.

4. You cann’t install the activation code on another MyPBX.
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2 MyPBX Client Addon Settings

You can disable/enable/update the addon after it is activated successfully.

MyPBX Client (Enabled)

PV MyPBEX Client is an application coordinated with MyPBX that connects your PC and IP phones. With MyPBX Client, you can perform various operations + Update
a’ including check extension status, manage contacts, voicemails, and CDR of extension. realize click-to-call and call popup, send instant messages between
extensions, initiate a conference call, and create a call task, etc ® Disable
(Figure 2-1)

Disable MyPBX Client addon

You can click “Disable” to disable MyPBX client addon temporarily.
Click “Disable”, MyPBX will pop up the window below, and then click “OK” to disable it.

' ™
oo vy S =

(Figure 2-2)

Enable MyPBX Client addon

If you have disabled MyPBX client addon, you can enable it again by clicking “Enable”.
MyPBX Client (Disabled)

MyPBX Client is an application coordinated with MyPBX that connects your PC and IP phones. With MyPBX Client, you can perform various operations + Update
a’ including check extension status, manage contacts, voicemails, and CDR of extension, realize click-te-call and call popup, send instant messages between

extensions, initiate a conference call, and create a call task, etc.
(Figure 2-3)
Update MyPBX client addon license

If you want to change the number of client which MyPBX supports, click “Update” and enter
the activation code and client number to active it again.

MyPBX Client (Enabled)

MyPBX Client is an application coordinated with MyPBX that connects your PC and IP phones. With MyPBX Client, you can perform various operations | + Update |
a’ including check extension status, manage contacts, voicemails, and CDR of extension, realize click-te-call and call popup, send instant b
extensions, initiate a conference call, and create a call task, etc. ® Disable
(Figure 2-4)
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Install MyPBX Client X

MAC: f4b549060134

Client Number: &0

Active Code: REYETR-CEFGF8D2D24F4FAQADCAC16666F1F12E

o Active | 3£ Cancel

(Figure 2-5)
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Part 2 How to use Client software

1 Introduction

MyPBX Client has clean and user-friendly interface as well as lovely icons. The simple and
human-based practices allow users to click to call out so easily that they don’t need to
remember any number; when users engaged themselves in thinking, no need to be
disturbed or annoyed by constant ringing tones, just give a “command” and MyPBX Client
will help you to politely decline incoming calls; when users are absent, no need to worry
about missing any important calls, MyPBX Client can help record voice messages.

Not only is MyPBX Client with call management functions that can easily manage the call
conference, voicemails and call recordings, but also a unified communication terminal that
can send internal instant messages.

www.yeastar.com Page 8
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2 Install MyPBX Client

This section shows how to install MyPBX Client software on the PC.

1. Download the MyPBX from
http://www.yeastar.com/download/MyPBX-Client/MyPBXClientSetup1.0.0.4.exe

2. Double click the “MyPBX ClientSetup1.0.0.4.exe”, “Welcome to the MyPBX Client
Installation” screen will come up. Click “Next” to continue.

4 Installing EyPBE Client

Welcome to the MyPBX Client

Installation!
C:;c_;: . This setup pragrarn will install MyPBX Client on your cormputer.
o :".}'*. Click Exit if vou do not want to install this application. Click MNext
et to continue the installation,

WARMING: This program is protected by international copyright
L law and
treaties,

Unauthorized repraduction or distribution of this pragrarm, or any
portion of it, may result in severe civil and criminal penalties and
will be prosecuted to the maximum extent of the law.,

(Figure 2-1)

3. Read through the software License Agreement, select “l agree with the above terms and
conditions”, and then click Next to continue. See Figure2-2.
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% ]
License Agreement

To proceed with the installation, you must accept this License EFJ“‘E\“J
Agreement. Please read it carefully. )

Entering into this Agreement: (MyPBX Client) ”

This End User License Agreement constitutes a valid and binding agreement
between Yeastar's MyPBX software {('Software') and You, as a user, for the use
of the Software.

Article 1 License and Restrictions

1.1 License, Subject to the terms of this Agreement, Yeastar hereby grants vou
a limited, personal or commpany, commercial, exclusive, sub licensable,
assignable, charge license to download, install and use the veastar Software on
Your camputer,

[¥|1 agree with the above terms and conditions

< Back MNext = ] [ Exit

(Figure 2-2)

4. Click Next after going over the provisions.

2 x|

Readme P
Please read the following information. '%r‘“@
MyPB® Client: Easy-to-use call messenger at vour fingertips ”

MyPBx Client is an easy-to-use application of MyPBX designed to provide fully
integrated unified communications for SMBs,

with MyPB» Client, the user is able to see the status or presence of the other
users, click to call from the phonebook ar Microsoft Qutloak; see missed,
inbound and outbound calls; create and manage conference calls; schedule call
tasks; checl: voicernails and recordings, to name just a few.

To top it off, MyPB»x Client offers instant messaging (IM), email and SMS
functionality that gives users the power to guick contact people in either local or
remote locations; also it enables users to have sidebar conversations during
calls, or to bring several people into a chat session,

once installed, there will be a shortcut of MyPB¥ client on the desktop, Double
click it, and then the user can manage their extension easily from desktop.

< Baclk Mext = Exit
0

(Figure 2-3)

5. The Destination folder screen allows you to decide where to store MyPBX Client on your
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computer. Click “"Next” to continue.

42 Installing EyPBE Client

Destination folder

_Seleu:t a destination folder where MyPBEX Client will be 5‘;‘@
installed.

Setup will install files in the following folder.

If vou waould like to install MyPBX Client into a different folder then click
Browse and select anaother falder,

Destination folder

CiWProgram FilesWreastar’\MyPBRClient [m]l

< Back Mext = | Exit

(Figure 2-4)

6. A screen pops up to notify you that:
(1) Run Installed application
(2) Create Shortcut(s) on Desktop
(3) Start MyPBX Client when | start Windows
Enable the options as you wish, and then click ‘Next’.

www.yeastar.com Page 11
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E_Installlng E¥PEX Client

Select from the following installation options.
Click Mext ta begin the installation. Click Back if you would like to change the

installation information,

[*]Run Installed application
[¥] Create Shortcut(s) on Desktop
Start MyPBE¥ Client when I start windaows

(Figure 2-5)

7. Enter into the “Installing Files” page. The system begins the installation, which will take a

while.

42 Installing NyPBE Client

Installing Files P
Capying MyPB¥ Client files to your computer, ﬁq“-,ﬁb

To interrupt or pause the installation process, click Cancel.

Directory: O
File: MyPBX exe

(RNRNNRNRRNNNNRANRNRANRAE )

MNext =

(Figure 2-6)
8. When the installation is complete, a screen will pop up to notify you that the software is

installed successfully. Click Finish.
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MyPBX Client has been
successfully installed!

Clicl: Finish to complete the installation.

(Figure 2-7)
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3 Log in MyPBX Client

After the installation, you can enjoy the powerful functions MyPBX Client offers.

Double-click shortcutm and launch MyPBX Client. Please enter your Ext. number and

password and then click “Sign In”, see Figure 3-1.

M EyPEX

File Help

Eztension
6041 £

Pazsword
EEE]

Sign me in when Client starts

Start Client when computer starts

Please pay attention when you log
in for the first time:

Please click “Tools” on
menu->Options, and enter the IP
address of MyPBX Server and
Client Developer on Figure 3-2. You
can get this IP and developer from
Admin.

About Ext. and Password

Obtain the Extension and Password
from your system Admin before you
log in MyPBX Client. The password
for extension is the voicemail PIN.

Check it on the extension edit page
on MyPBX.
If you want to modify password,
please see details on Chapter 4.7
Personal Profile.
(Figure 3-1)

www.yeastar.com
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Fill in MyPBX IP

Server IP address:; 152.168.5.101

Cliert Developer: ¥yea

Fill in Developer "yea"

Sign me in when Cliert starts

Start Client when computer starts

| oK || cancel || Aol

(Figure 3-2)

Note: On Sign in screen, you can also enable following settings:

Sig;n me in when Client starts

Sta.rt Client when computer starts

www.yeastar.com Page 15
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4 Managing MyPBX Client

4.1 Extension Management

When sign in MyPBX, system opens a main screen—> Extension screen as Figure 4-1 shows.

Here you can edit your
profile.

Enter the ext. number you
want to call here, or choose a
dialed number through the
pull-down button.

Call button, call the number
entered in the above frame.

\!

Call Task (pull-down)
You can create, show, clear
and refresh all tasks.

ﬁMyPBK—ﬁIZHI | o e S
File View Contacts Tools Help
% -
6041(Oriine) .
| Call task /g Corference
J Exdensions || Contacts || Histony ”\"u"oicemail ” Hecordingl
1 extensions online
© Name Bttno | Mobile  ~
o8 O dack 6041
o ) FRe 029
., . Prince 6028
& & Myon 6023 =
7 Michael 6026
o ey 6024
o 4F dason 6020
oy dane 6025 L4
= _':}"’ Hamy 6021
. oy Catherine 6022
o 7 Athur B0Z7
8 P e 5049
& Oy 6048 6048 -
' m 3
X
=

(Figure 4-1)

Conference
Open a conference window
with selected member.

Click here you can show or hide
keyboard (Figure 4-2)

End call button

www.yeastar.com
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|"|

( [7) MyPBx - 6041 =E] =

File View Contacts Tools Help
3 -
6041{Cnline) -
" \Calltask ~ &2 Conference
J E:dmsinns“ Cortacts || Histur'_r” Voicemail ” Hacurding|

1 extensions online
C Name  Ettro | Mobile  ~
8 P £041
o R 6029
o 4y Prnce 6028
S & Myon 6023 =
o 4F  Michael 6026
8 ey £024
o 4F dason 6020
5 :}‘ Jane 6025 | M
5 _'?‘ Hamy 6021
. j Catherine 6022
o o Athur 6027
&5 Oy 604 6043
& o7 6048 6048 -
€| m 3

=

5
El

B s =
=l R
TN

—
@ h Y

(Figure 4-2)

3 Indicates client user is offline
S Indicates client user is online
7 Indicates extension is unregistered or unavailable
:? Indicates extension is idle
-

& Indicates extension is ringing

& Indicates extension is busy
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4.2 Contacts Management

After signed in MyPBX Client, you can see “Contacts” tag as Figure 4-3 shows. Here, you can add,

edit, delete, send, import and export your private contacts.

M EyPBE — 6041 M=1E3
File View Contactzs Tools Help
ﬁ -
BO41 [Online)
\Call task v 82 Conference
Extensions ” Contacts || Hiztory ” Yolcamall || Recording
Hame Office Mobile
"-'-5 Mango ZB39952 13015932066
"-'-5 Banana SHTZRYS 13074855179
"-'-5 Haw FEZEG1S 13400823025
"-'-5 Orange 29507TT 13599902652
"-'-5 Lemon S16TOET 13606914305
"-'-5 Cherry 05TTRZS15009 13TeTTTRETS
I "-'-5 Apple STEE06E 13506095554
"-'-5 Fear BOZ1325 15959373125
i?.l- Eric 0Z16B3E5Z06 156802101955
[
< A
-]
253
23
(Figure 4-3)

4.2.1 Contacts Group Management

You can see contacts in group through “View” > “Show Contacts Group” (see Figure 4-4).
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File BERSS Contacts Tools Help

v Show dial panel

Add new group

Contact
list

selected

4.2.2 Add New Contact

GCAN| ¥ Show contacts group -
'__._:__Call tasl - %Cnnference
Extenzions || Contacts || ]'[istu:-r}'” Voilcemall || Recording
— <
S Add Group ?(:Delete Gt oup |
Delete
Hame Office Mobile
o group
Colleagues &b Tona 5T02543 15253213512
Friends ".‘]‘ Fhilip SR34022 1342522352
Ungrouped ".‘]‘ TonyZhang TE15551 1355002124
".‘]‘ SinTom 5TOZ5R0 15882315054
I._- w Kewi
v evin 52340835 15022838232
groups — o
"-‘]‘ Jeszecica T1552352 1505241 3652
".‘]‘ catherine Z01BER4S 15880285416
".‘]‘ HFryomy B4B5E2E 15426527524
".‘]‘ Ben 15E43R63 15244565285
L >
57025430 E"
-~ [ e |
‘ ?n ' 45 8
raew
LY = ‘ * rl
(Figure 4-4)

1. You can add new contact through Menu—>Add New Contact (Figure 4-5a) or click the mouse to

open the adding screen as Figure 4-5b shows.

www.yeastar.com
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M EyPBR - 6041

M EyPBE — 6041

File Tools Help File Vier Contscts Tools Help
Ad ot
8- ; &~
 Bdit contact’s profile. .
04 Mndine ooy, oo 8041 (Irline)
Ol tes T contact [ Call task v 8 Conference
Extensions or ding Extensions || Contacts || History || Voicenail || Recording
| — : \ | [[Histors] [[Fecording]
[inid Gro [ 8dd Group X Delete Group
Upload loesl data to server
Dowiload alient dets fice Mobile Fane 0ffice Mobile
Tord 5702543 15253213512 Teni mooses
Colleagues P+ Colleagues & Add nev contact. ..
Fei ends & Bhilip 5634022 1342522352 Friends & mhilip Biit comtact's profile,.  [Z92235C
Vngrouped & TanpZhang 7515551 1355902124 ngrouped & Tonyiheng Move ta Group B5002124
&, Silon 5702580 15862315954 & sinlon Start eell 282315954
& Tevin 52340635 15922738237 & Fevin Delete contact 822535232
& Jesseiea 71552352 15952413652 & Tessciea 852413652
& catherine 25186645 15880285416 & catherine Refresh 80285416
& Yngony 5465528 15426527524 & Foyony £465528 15426527524
& Ba 15643863 15244565285 & B 15643663 15244565285
4] 2 & 2
8102543 x] 6702543 x|
— faimn| — e
obo 158 Nite a5 e
@ ree @ L
0 ~0 e

(Figure 4-5a)

(Figure 4-5b)

2. Please edit contact’s profile on the following screen; the details include name, office phone,

and company name and so on. (Figure 4-6)

M Add new contact __

& Contact™ = profile

Name (Green_tea |
Group Ungrouped v|
0ffice 91284513 | Memo
Mobile 131235264585 |
Home | |
Company Teastar |
Title | | Fax | |
E-mail ‘tealyeastar. con | SKYPE  |support. yeastar
Postcods | | MsH | |
Weh v, yeastar. con |
hddress | |
tpply || ok || cancel |
(Figure 4-6)
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3. Click “Ok” or “Apply” to add new contact.

Note: On call history, right click on the item and from the menu you can “Save Number” to your

contacts.

4.2.3 Edit Contact’s Profile

1. Click on the chosen contact, and open the “Contact” menu—> “Edit contact’s profile” as Figure
4-7a shows or right click to open the menu as Figure 4-7b shows.

G041 |f (=] M EyPEE - 6041

File Vier Tools Help File View Contacts Tools Help
d - idd new contact. 5 -
B0 (inline B041 (ndline)
CCel tss gt contact, L Call task v 8% Conference
Extensions ik Extensions|| Contacts|| Kistory|| Voicenail|[ Recording
T —— [ectonsn ot isory et et Bncoriog
[i8 4dd Gror [ dd Group X Delete Growp
Upload local data to server
Dowrload elient data fice Mobile i Lt Dl
Colleagnes |00 T60 02543 15253213512 Colleagues £ Toni 53213512
Friends & hilip Sesdnzz 1347522352 Friends & Philip 42522952
Ungrouped & Temglheng 7515551 1355802124 Ungrouped & TonyZhang !::l‘:ai““l’ B55a02124
& SisTon ST02580 15882315954 & SixTon BAA2315954
Delet, tact. .
& Revin SO 15022838232 & Fevin eete montes Earenanza
& Tesscica 71558352 15852413652 & Jesscica Bo5241 3652
& catherine 25166645 15580265416 & catherine | Befresh EGA0RE5416
& Hogony B4B5525 15476527524 & Fuyony £465526 15426527524
8 B 15643663 15244565255 & Ben 15643863 15744585285
< > 4 Ed
5702543 Jx]| |s702543 x|
_ e N rea
‘.‘_’ a5 ‘”i ase
T80 »80
0w -0 J
(Figure 4-7a) (Figure 4-7b)

2. Here you can modify the contact’s information. See Figure 4-8.

www.yeastar.com Page 21



90 Yeastar MyPBX Client Manual

X)

~@ Contact”s profile
Name Philip |
Group Tngrouped vl
Office 5684022 | Memo
Mobile 1342522352 |
Home | |
Comp ary | |
Title | | Fax | |
E-mail | | SKYFE |
Postcode | | MSH | |
vt | |
Address | |
| ok || rcancel |
(Figure 4-8)

3. Click “OK” to save the changes.

4.2.4 Delete Contact

1. You can delete the chosen contact through menu “Contacts”>“Delete contact” or click on
right mouse to delete directly.
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M XyPBX - 6041

M EyPBE — 6041

Tools Help File View Contacts Tools Help
Add new contact. ..
8- . 8-
8041 (Inline 8041 (Online)
LICAl1 tas s sontart, [!Call task v & Conference
Extensions or ding Extensions || Contacts || History|| ¥oicemail || Recording
|ETEST — [ [ Contacts [Fistors | | \
[ dd Gro [Ad2 Growp X Delete Group
—— | lUpload local data to server
Download client data fice Mobile Fane Dffice Meobile
Celleszues & Tont 502543 16253213512 Collesgues & Teni 5702543 16253213512
Friends 5, Philip 5664022 1342522352 Friends 5, Fhilip ERRAMD2 1342522352
o o Add mew contact
Ungronped & Temglheng 7515551 1355902124 Ungroupad & Tomlhang | pa s profile. 1355802124
& SinTon 5702560 15867315954 &, sixTon Wove Lo Group 15882315954
& Tevin 52340635 15322639232 & Kevin Start edll... 15922639292
& Jesseiea 71552352 15952413652 & Tessciea 15952413652
& catherine 25188645 15860285418 & catherine 15850285416
& togory 548528 15426527524 & Foyony Refresh 15426527524
& Ben 15643663 15244565285 & Ben 15643663 15244585285
] > ] bl
5684022 x| [s68a022 ]
= (s | — [lamm|
onn a5 68 noo 458
@ L] @ L
-0 ® B R
| |
(Figure 4-9a) (Figure 4-9b)

2.Click “Yes” to delete this contact as Figure 4-10 shows.

o ==

| Areyou sure to delete the selected contact?

= )

(Figure 4-10)

4.2.5 Import Contact

1. You can import contacts from menu “Contacts”--> “Import Contact”.

www.yeastar.com Page 23



> ® .
'. Yeastar MyPBX Client Manual
S=1e3
File View BMIAENEEN Toolz Help
5 - Add new contact. ..
_ Edit contact’ s profile. ..
8041 (Online Delete contact. ..
—-:-I:all iz Import contact. ..
Extenzions ording
Export contact...
[iAdd Gro
I Upload local data to server
#11 Download client data Efice Mobile
Colleazues _ﬁ. Fhilip ShE4022 1342522352
Friends -L!;a TonyZhang 7515551 1355902124
-L!;a SinTom STOZ5E0 15552315954
-L!;a Kewin 2340635 15922535232
‘5, Jesseica T1552352 15952413652
-L!;a catherine 25186645 15550255416
-L!;a Hoyony G4B5525 15426527524
-L!;a Een 15643863 15244565255
< &
F684022 ]|
— T
i1 45 &
Few
= 0 & ]

(Figure 4-11)

2. Select the file (.csv) you want to import and click “Open” button (figure 4-12).
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o ® e m

File nhame:

ICDntacts.csv

Open

Filez af hpe: I[".cw]

[~ Open as read-only

S
-] Cancel |

&

(Figur

e 4-12)

3. Double click the item to select corresponding address, see Figure 4-13.

M Nap the field=s you wish to import

Text fields
“Dizplaylame”
"Of ficelumber”
“Mobillumber”
“OtherMumber”
“Line”

“Eing”

“Group”

Addrezz book fields
Lazt Name

Office Phone

Family Name
Last Name
Mobile Phone
Home Phone
Group

Job Title
Company
Fax

MSN

aDnuble click i1tem to =zele

Skype
Postcode
Address
Email
Webh

(Figure 4-

4. Click “OK” to finish this step.

4.2.6 Export Contacts

1. You can export contacts to save o

13)

n computer as well. See Figure 4-14.
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File VWiew ICuntacIs Tocols Help

Add new contact...
Edit contact's profile...
Delete contact...

Import contact...

G
VAR R RV RVRVRVRV AR

Export contact...

Wyran

Jemy

2 g

Upload local data to server

m Download client data -

o

;

(Figure 4-14)

2. Select the routing that you want to save, and then click “Save” to finish as Figure 4-15 shows.
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saveas 20 x|
Savejn:lE}EDDE j € A i

File narne: |I:|:|nta|:ts Save I
Save as pe: |[".csv) =] Cancel |

(Figure 4-15)

4.2.7 Upload local data to server

You can upload local data to MyPBX server to save it. See Figure 4-16.
Note: If you have uploaded local data to MyPBX server and you want to upload it again, your
data on MyPBX server will be covered with new data.
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- BX

File View BMSEEVEEN Toolz Help

5 £dd new contact. ..
-

B041 (Online

. Call tas Import contact. ..

Extensions ording
Export contact. ..

[ Add Grg
Download client data fice Mobile
Colleagues o Toend 02543 15253213512
Friends "!5,‘ Fhilip SBG4022 1342522352
Ungrouped "!5,‘ TonyZhang 515551 1355902124
"!5,‘ SinTom ST0Z560 15562315954
"!5,‘ Kewin 92340635 19922836232
‘5‘ Jesscica T1952352 15952415652
"!5,‘ catherine 25166545 15560255416
"!5,‘ Hnyony B4B25E5 15426527524
"!5,‘ Ben 15643665 15244565255
< >

d]

LAk I N
(=20 % N
- e

(Figure 4-16)

4.2.8 Download client data

Since you have uploaded local data to MyPBX server, the next time you change a PC to log in
MyPBX Client, you can download client data from MyPBX server using the same username. The
operation is also used in case of losing data.

Note: If you download client data, the local data on PC will be covered.
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M EyPBE - 6041 M=1E3

File WView EMEGAETIEN Tools Help

Add new contact. ..
'3 -

B041 (Online

. Call tas Import contact. ..

Extensions nrdingl
Export contact. ..

[ Add Gro

Download client data fice Mebile

Colleagues &b 02543 15253213512

Friends lgt Fhilip SBE4022 1342522352

Ungrouped lgt Tonyfhang 7515551 1355902124
lgt SinTom STOZS60 15882315954
lgt Eevin 52340635 159228358232
‘ﬂ Jezs=cica T1552352 159524135652
lgt catherine 25166645 15830235416
lgt Hngrongy B4B5525 154268527524
lgt Een 15643663 15244585285

[
|

e
(=N N
-

(Figure 4-17)

4.3 Call History

After signed in MyPBX Client, click “History” tag to enter the call log screen (Figure 4-18). Here
you can see all the calls that have you made or answered. Call information including callee name,

telephone number, call time, and duration will be available on the list.
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M E¥PEX — 6041

5'

B041 (Inline]

File V¥iew Contacts Toolz Help

'_h.i,Call task = %Conference

| Extenzions || Conta-:ts” Historﬁl,‘i'oicemail” Recording

Humber

) 554D

&) 6013

3
Right click on the selected item, I/,?;;sssmssmss

you can generate a call, save
number or delete this item from

the list.

| .y

Hame Call time
Toni 2013-01-12 10:42:40

Toram n13-01-12 10:29: 18

3-01-12 10:25:16

Sawe number. ..

3-01-12 09:18:53

Remowe from histories. ..

Remowe &ll. ..

Refresh

Dharation

00:00:00
00:00:52
00:00:00
00:00:06

You can arrange items in
sequence according to call
types, number, name, call time,

and duration.

0 Stands for incoming call
&) Stands for outgoing call
& Stands for missed call

(Figure 4-18)

4.4 Voicemail Management

After signed in MyPBX Client, click “Voicemail” tag to enter the voicemail listing screen (Figure

4-19). Here you can see all the caller number, name, call time, and duration.
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M XyPBY — 6041 Mi=E3
File WView Contactz Tools Help
d -
B041 Orline)
'_;:r_Call task = %Cnnference
| Exten=zions || Contacts ” ]'[ist-:-r}'” Voicemail ” Recording
. SaFey LN Stop Button
al
Y . . Inbox Humber Hame Call| | Click this button to stop the
Play selected voicemail. When - .
i i 014 [=] 8013 Jason 2013 | playing.
playing, click the button to
pause it. Worl [ BO31 Jane 2013
Family
Friends
< >
Ad]
o
4 5 &
rae
= 0 *_.

(Figure 4-19)

[=] Unread message

[~ Read message

Inbox: the folder where new message is stored
Old: after reading the message, the message will be automatically moved to this folder
Work: after reading the message, the message can be moved to this folder

Family: after reading the message, the message can be moved to this folder

Friend: after reading the message, the message can be moved to this folder

Note: You can call the number, save or delete the voicemail through right-clicking, but you can’t

directly move the message to other folders.
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4.5 Recording Management

After signed in MyPBX Client, click the “Reading” tag to enter the calls reading list screen (Figure
4-20). Here you can see all the status, call time, and duration.

"] MyPBX - 6024 C=rear X
File View Contacts Tools Help

6024{0nline) 1s
© \Calltask v 2 Corference

| Extensions ” Cortacts ” Histur).r” Yoicemail || Recording || Call |

WaPlay Ly Stop Button
Play | Number | Name | Call time Click this button to stop the
Play selected recording. When Q a2 Sandy 2013-05-11 recording of the current call.
playing, click the button to Q 6072 Sandy 20130511
pause it. Q 690 01
L I F
|T
(1ol e |
|
PoE o9
| = 0 &

(Figure 4-20)

Note: You can call the number, save or delete the recording through right-clicking.
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4.6 Call Status Management

1. When there’s an incoming call, a prompt screen will show the caller’s detailed information.

M EyPBE - 6041

File V¥iew Contactz Tools Help
&v
8041 (Online)

Call task = 2

| Extensions || Contacts ” Histor}'” Volcemail ” Recording” Call |

If you have already .
edited the caller or k\&*"

6013

extension’s profile, it >J’ob Title:
Company:

will display the profile.
r’/ Keb:

Click here to forward the
incoming other extension
or outside numbers

Click this button

@ to reject the call.
|

(Figure 4-21)

2. When there’s an outgoing call, a prompt window will show the callee’s detailed information.
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M EyPBY — 6041 =13

File Wiew Contacts Taols Help
.5 -
B041 Online)

. Call task v 2

Extensions ” Contacts || ]'[istl:-r}'” Yolcemall || Recording” Call |

Q_’ Jason
; 6013
Job Title:

Company:
Web:

]

)}

(Figure 4-22)
3. During a call, it prompts as Figure 4-23 shows.
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M 8501 - s AEE
File View Contactz Tools Help
d -

8041 [Mrline)

el task v 2

Extenzions || Contacts ” History” Yoicemail || Recording” Call |

"1 Jason
Hold O % — 6013
0 n TJob Title:

Click this button,
it will hold on the

call.
L | Record Button
Click this button
Call Forward to record the
Click this button conversation.

to forward the call gﬂ A @ @
Ml e

to other extension/

tacts/ri 00:00:09
contacts/ring .
Group | = Time
: ves Show call
% ofok duration
(Figure 4-23)

4.7 Personal Profile

For the convenient communication with your colleagues and friends, MyPBX Client provides
personal information management, so that you can update profile at any time.
After signed in MyPBX Client, click “File” = “Edit profile” to open personal information screen.
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- "
7] MyPBX - 6041 E=npEn X

File | View Contacts Tools Help
Edit profile...
Change password... ok
Sign out
[ Tedensions orline .
© Name ' Extno | Mobile
o ) Jack 5041
5 R 6028
o o Prnce 6028
o &7 Myon 5023 3
o 7 Michael 6026
o ey 6024
o 47 Jason 6020
o dane 6025 B
o &y Hany 6021
o 4y Catherine 6022
o 7 Athur 6027
8 P 049
o 6048 6048 y
4| 1 3

5
=

B
L=l
-

F —'y
@ A T 4

(Figure 4-24)

M Edit your profile

Name | catherine |

Mobile 15680270231 |

| o0k || Cancel

(Figure 4-25)
Here you are allowed to change name, mobile phone number.
You can change password through “File”—> “Change Password” setting as Figure 4-28 shows.

Open the password screen as Figure 4-26 shows and enter both the old and new password, after
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which a pop-up will prompt you as Figure 4-27 shows.

M Change password

X

01ld password

|**** |

New paszsword

|**** |

Eepeat new pazsword

(Figure 4-26)

Modify password successfully, it will take affect log in again.

(Figure 4-27)

4.8 Refresh

You can right click the mouse and click “Refresh” on menu as Figure 4-28 shows to gain the latest

data. For example, the current page shows all extensions, MyPBX Client will get the extension
information again after clicking “Refresh”.
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File VWiew Contacts Tools Help

" \Calltask v 82, Conference

J Eﬂm“ Eurrtacts” I-ﬁstory” Voicemail ” Hﬂmrdlng|

1 extensions onling

© Name
s ..'(? Jack
) Rela

rel -y

| 4

6o Go Go Co Co Co ¢o o Co Co B8
"AAAA A AL LR

|Eltm

6041

Start chat...
Send SM5...
Start call...

Pick up call

Refresh

Chat history...

£

5

(Figure 4-28)
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4.9 Show Dial Panel or Not

You can set up whether or not to show dial panel on menu “View”-> “Show dial panel”. (Figure
4-29)
M EyPEX — 6041 =13

M EyPBX — 6041

File View Contacts Tools Help
Contacts Tools Help
\3 v 5
B @sdline] §041 (1 Show contacts group
(R0 Goels & | Bonffare: " !Call task = 82 Conference
Ext Contacts| Hist ¥ 1| Record —
[Extensions |[Contacts]| History|[ Voicenail|[ Recordine [Extensions | Contacts|[Hiztory|[ Veicenail |[Recording
2 extensions online 2 = =]
extensions onlime
Hame Ext.no Mo u -_ "
ame 2t no o
8 O wER 8040 oo
oLy BkaEER 6040
& F cutherine 80 15t 4, I catherine 6041 15¢
S Dy s 305 Oy ms 305
s :'; 304 304 8 _';-" 304 304
S F W 303 R 303
& F e a0z 8 p 9o a0z
S F = ant e | 3ot
o oy s 300 o o s 300
< >
G40 x|
— 28
i
rew
< > o -

(Figure 4-29)
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4.10 Change Language

”

MyPBX Client has multiple language versions. You can change the Client language through “Tools

- “Change Language”. (See Figure 4-30)

File View Contacts ITouIs Help

Change Language BRI (Chinese Simplified)
ST (Chinese Traditional)
English

Options...

 Calltask v 52 Confersnce

J 'E:demstons“ Contacts || Histnr'_.r” Yoicemail ” Hecurding|

1 extensions online
© MName ' Extno | Mobile  *
Jack 6041
6029
6028
6023
6026
6024
6020
6025
6021
6022
6027
6049

te
¢

S 9
S 9
L 4
SS9
S 9
89
S 9
89
S 9
S 9
S 9
S 9

A

2

(Figure 4-30)
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4.11 Call Forwarding

You can forward incoming calls at any time. Configure it through “Tools” = “Options” (Figure
4-31).

MyPBX - Options o

System Call forward
Call forward E
Feature Codes
Speed Dials [T Aways -
@ Yaice Mail
Calls Mo Angwer Transferto:
) Number
When Busy
| ok || Cancel Apply

(Figure 4-31)
* Always: Always forward calls
# No answer: If no answer calls will be forwarded to
* When Busy: forward calls when you are busy in a call

] Transfer to: the incoming call will be transferred to “Voice Mail” or the
designated “Number” according to your own demands.
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Note: If call forwarding is set to external line number, please input the prefix before number.
For example, “9” stands for PSTN trunk routing, “81” stands for SIP trunk routing, and “7”
stands for Skype trunk.

4.12 Feature Codes

You can check the shortcut operation of call on hold, pick up calls and so on. Click on
menu “Tools” > “Options”> “Feature Codes” (Figure 4-32a) or click on “Feature codes” on the

interface directly as Figure 4-32b shows.

File View Contacts ITooIs Help

s - Change Language [
6041(Onling) I Options... I %
| Calltask ~ 2, Confersnce [ Calltask ~ 8 Corference
J Extensicns” Contads” History” Voicemail ” Fleccrding| Extensions” Cortacts H Hi5t°"Y|| Voicemail H HBCOfdi”9|
1 extensions online 1 extensions online
T e s = | ] e o
8  Jack 6041 8P
& F Rea 6029 &9
o Oy Prince 6028 | 4
8P ten s Al e
o O Michael 6026 L
8P wn s 82
o & dason 6020 89
O dane 6025 L | 4
8 G Hawy 6021 8
o ij Catherne 6022 8 &
o 7 Athur 6027 4
8 P e i 82
8 P e e 1 IEE:
< I b <
|6{}28 _]I 6028
Py e
@ ; e
b ¥ -0

(Figure 4-32a) (Figure 4-32b)
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System

Call forward
Speed Dials
Calls

General
One Touch Record [
Extension for Checking Voicemai |
Voicemail Main Menu 02 ¥
Attended Transfer El
Blind Transfer *03 [#

Extension Fickup [+
Intercom [
Call Parking O

Mormal Spy 50 [¥]
Whisper Spy ] [#]
Barge Spy 52 ¥
Call Forwarding Preferences
Reset to Defaults “70 ]
Enable Forward All Calls 71 |
Disable Forward All Calls E
Enable Forward When Busy 72 B
Disable Forward When Busy ¥
Enable Farward No Answer 73 ¥
Disable Forward Mo Answer ¥
Forward to Number =74 #
Forward to Voicemail ¥
Enable Do Not Disturb 75 ¥

Disable Do Not Disturb H

Lok J[ Cancel || sopi |

4.13 Speed-dial

(Figure 4-33)

On menu “Tools”=> “Options” > “Speed Dial”, you can check the speed-dial number on Figure
4-34. For example, if you want to call number 918859206002, then just dial 123 directly.
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Call forward Prefix Substiute |
Feature Codes & 123 918359206002
RS & = swomor
Calls
Lok J[ Concel J[ oo
(Figure 4-34)
4.14 Calls

Through the menu “Tools” - “Options”—> “Calls” to manage the calls.

www.yeastar.com Page 44



90 Yeastar MyPBX Client Manual
Wl

System Calls

Call forward

Pop-up window when someone call in
Feature Codes

Speed Dials Dial Pattem 3.
Calls
Automatically answer dialing out
Phone Type Yealink -
Agstra
Fanvil
GRANDSTREAM

Fnﬁum

ok J[ Cancdl J[ ey

(Figure 4-35)

#* Pop-up windows when someone call in: Client will bomb the caller’s ID for an incoming call.
= Dial Pattern

= Automatically answer dialing out: When you enable this option and click a number to dial out,
your IP phone will answer it first.

Note: You should select your IP phone type correctly. For example, if you are using Yealink IP
phone, please select Yealink.
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File View Contacts Tools | Help
About MyPBX...

© \Calltask v 52 Confersnce
J Em:'m“ Cortacts ” Histnry” Yoicemail || Hemrding|
2 extensions online

C Name

6o Go Go Go Go Go Go Go Go Go Co Go
VA A AR A A A A A AR

A

13812345678

(Figure 4-36)

4.15.1 About MyPBX Client

You can know the MyPBX Client version number and copyright through menu “Help” = “About
MyPBX Client”. See Figure 4-37.
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M About NyPBX

MyPBX

MyPEX Client Version 1.0.0.4

Copyright (C):
2011-2012 YEASTAR TECHNOLOGY

http:/ wnr. yeastar. com

(Figure 4-37)

4.16 Sign out & Exit

You can exit from MyPBX Client on menu “File” > “Exit” or you can click on MyPBX icon on right
tray and click “Exit” to exit as Figure 4-38 shows.

Open MyTPEX

(Figure 4-38)
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5 Main Functions

5.1 Dialing Call

Press a key to dial out easily on MyPBX Client that simple the dialing procedure and save time.
Just move the mouse on the telephone and click it to dial out.

5.1.1 Call Internal Extension Number

You can call an extension number through three ways:

(1) Double click the selected Ext. number to call out

(2) Enter the Ext. number on the input box below and click “Call” button or “Enter” to call out
(3) Click the Ext. number on the panel and then click “Call” or “Enter” to call out

‘“!.:Lil.e View Contacts Tools Help

oo |
6041(0nline) E =
\Calitask = &2 Conference
J Extensions || Cortacts || History” Voicemail || Hecording|

1 exdensions online

© MName | Extno Mobile *

8 P ack 6041

5 3 Rel 5029

8 IF Prnce 6028

3 '? Myron 5023 Start chat...

& P Mehoe £0zs Send SMS...

8 F low 0z

& ? Jason 6020 _

j _}‘ Jane 025 Pick up call

:'" :y Hamy &021 Refresh

L. & Catherine 8022 Chat history...

o O Athur 6027
Enter telephone 8 r em9 6049
number here to L 6e0és 6042 e
call out < . -

6023 |

n— |
() |
(Figure 5-1)
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5.1.2 Call External Line Number

(1) Call external line numbers on contacts list: You can double click on the selected number, and
the system will call it with default routing. (If you don’t want to use the default routing, just select
the number and change the prefix on the input box below, system will save this new prefix and

apply it to this number when you call it out next time).

M EyPEX — 6041

File View Contacts Tools Help
S
8041 (Online)
'_i.Call task * S Conference
@ 1 Miszed calls
| Extenszions || Contacts ” ]'[istor}'” Voicemail ” Recording|
mﬁ.dd Group ?{Delete Group
Hame 0ffice Wobile
i . Tomi BT02543 15253213512
Double click ¥  Phili S6E4022 .1342522352
. Friend - 1L1p
it to call out TheneE o
lngrouped “; TonyZhang 7515551 1355902124
:.: SinTom 5702560 15882315354
“; Kevin 52340835 159228358232
“; Jesseica 71552352 15952413652
“; catherine 25166645 15830255416
“.; Hnyony B465525 15426527524
:.: Ben 15643663 15244565285
. o T BOG1
Number  will  be 0 7%
. @ B013
shown on input G Je=om
box. ‘9 is the
. £ »
prefix of default
routing. t”
Ve
45 8
P
=0 #
(Figure 5-2)

(2) Call external line numbers that are not on contacts list: You can enter the number on the input
box and add the prefix to it, such as “9” for PSTN line routing, “81” for SIP routing; you can
enquiry Admin for other settings. System will auto call this number out from an idle trunk.

5.1.3 Call back a missed call

When you miss the incoming calls, just do as follows:
(1) Double click the number on History list and call out by default routing.
(2) Select the number on History list and add the prefix on input box to call out through
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designated routing.

5.2 Incoming Calls

You can execute the following operations for an incoming call:
* reject it

M EyPBE - 6041

File View Contacts Tools Help
57
BO41 (Irline)

Call task v 8

Extenszions ” Contacts ” History” Yoicemail ” Recording” Call |

o 6013

TJob Title:
Company:
Heb:

I| t“ Click here to

reject the call
= )
« 0 # J

(Figure 5-3)

5.3 Call Forward

Do you always encounter the following situations in office?

Answered a call only to find that you are not wanted on the phone but your colleague.

2. You are on a call, and there’s another incoming call that you don’t want to miss.
3. You are busy doing things and have no time to answer calls.
4. You have to go out, but don’t want to miss any calls.

Don’t worry. MyPBX Client will help you deal with these.
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5.3.1 Forward before a call

When you go out or are too busy to answer a call, you can forward incoming calls to your mobile

or other number. Please see details on 4.11 Call Forwarding.

5.3.2 Transfer during a call

Step 1: Click the “Transfer call” button as Figure 5-4 shows

M EyPEE — 6041

File Wiew Contacts Tools Help

dv

6041 Mrline)

Call task v M2

Extensions || Contacts ” ]'[istu:ur5r|| Yoicemail ” Re-:u:urding” Call |

& 6013

Job Title:
Company:
Web:

Click this button

i ———
i
Qe

0o:0o:01

e

LRL I B

-

(Figure 5-4)

Step 2: Select the number that you want to forward to on the pop-up screen (Figure 5-5). Click to

select a number, double click to forward call directly to this number. You can forward a call to an

extension, a contact, a ring group/IVR, or a telephone number entered on the input box. (You

need to add a prefix for forwarding to an external line number.)
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o ve o S ==

A Click to select number or double click to transfer
N

J Bxensions || D:urrtads|

Seanch extension...

© Name | Bdno | Mobile Home *
5 P Jason 6020
o @ Hamy G021
o, 4y Catherne 6022 =
5D e ooz
8 5 emy 6024
o ane 6025 | 4
L Mewe e
o o Athur 6027
o 4y Prnce 6028
o 4/ Rea 6025
8 > o 640 ;

£

] d 3

Or input the number
6026

[Transfer] [ Cancel ]

(Figure 5-5)
Step 3: Hang up the call to finish transferring or click “Flash” button to intercept a transferred
call.
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M EyPEE — fD41 |Z”E|[z|

File View Contacts Tools Help
d -
BO41 (Orline)
I Call task = 52
Extensions || Contacts ” ]'[istl:-r}'” Yolcema1l ” Recording” Call |
.;‘.-1
; L
« 6013
Job Title:
Comparny:
Web:
Hang up to
3'-") X @ 0 1f|n|sh
0000 20
]
oE e
/ 45 &
= 0 ‘.-
(Figure 5-6)

5.4 Call Parking

When you are on a call, you can park the current call on the Client instead of dialing feature code.
In this case, you can click the “Call Parking” button and then MyPBX will give you a parking
number. Dial this parking number on any extension to continue this call.
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Call Parking button
Click here to park the call

M EsPBE — 6041 M =ET
File ¥iew Contacts Tools Help
& -

B041 (Online)

Call task v 82

| Extensions ” Contacts || Histor}'” Yoicemail ” Recnrding” Call |

:.'x.v-l
o 6013

Job Title:
Company:
Heb:

gL

00:00: 20

L O
&5 é
rew
=0 # |

(Figure 5-7)

5.5 Pick up a Call

5.5.1 Pick up a call from appointed extension

When your colleague is absent, his phone keeps ringing, you can pick up this call through the

following way:

On extension list, choose the ringing or on hold extension, right click and click “Pick up Call” on

the pop-up screen as Figure 5-8 shows.
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(Figure 5-8)

5.6 Call Task

Call Task can help you to call out a number on scheduled time or remind you to make a call to a
preset number.

(1) You can conduct the corresponding operation through the drop-down screen as Figure 5-9
shows.
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(Figure 5-9)
Make new call task: click here to pop-up a screen as Figure 5-11 shows
Show all call tasks: click here to open the task list as Figure 5-10 shows
Clear all call task: click here to delete all pre-arranged tasks
Refresh call task: click here to refresh the tasks list
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@ Call task list X
Memo Call time Date MNumber
Taskl 09:55 Everyday 915968042352
Hew Edit Delete
(Figure 5-10)

New: Click here to create a new task as Figure 5-13 shows
Edit: Click here to edit the chosen task item
Delete: Click here to remove the selected task item

(2) Input the telephone number, call time, etc on window Figure 5-13.

8 Call task X

The number you want | [ e, __ TThEE

Select a time or
| period to call

to call
Date: | Everyvday V/" B " out
At what time you | = [Time: |IZI9 v| B |55 v| — | N £ thi
ame O IS
want to call
Memo: |Task1 | call task
Enable this function, when | — | ®only remind Ohuto-dial ] Enable this function. when
the time arrives, the system [ 0K ] [ Cancel ] the time arrives, the system

will only remind you to .
y y will call the number

make the call (Figure 5-11) automatically

(3) Click “OK” to finish creating or editing task. You will see the latest task on MyPBX Client

interface as Figure 5-12 shows.
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(Figure 5-12)

5.7 Call Conference

MyPBX provides the call conference for users. You can invite max.30 users to join the conference
by MyPBX Client.
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(Figure 5-13)

Step 1: Click “Call Conference” button to have the pop-up a screen as Figure 5-14 shows so as to
invite people to join a conference.
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(Figure 5-14)
Step 3: You are allowed to select people in the extension list to join this conference.

Step 4: Click “OK” to see the conference call interface as Figure 5-15 shows.

www.yeastar.com Page 60



% MyPBX Client Manual

M EyPEE — 6041 M=E3
File V¥iew Contacts Tools Help
& -

BO041 (Online)

Call task = 52
Exten=zions || Contacts || ]'[istu:-r}'” Voicemail || Rec-:-rding” Call |

oy
& Y 6041 —conference

Job Title:
Comp any:
eh:

PRI

0o:0o: 18

3R
5 &
LR
i#}

(Figure 5-15)

LOL W N

5.8 Internal Instant Message

MyPBX Client provides the internal instant message feature for users to chat easily with members

on the extensions list.

Step 1: On extensions list, select the member you want to chat with, right click to open the chat

screen.
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(Figure 5-16)
Step 2: Chat with selected extension user as Figure 5-17 shows.
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(Figure 5-17)

5.9 Voicemail

5.9.1 Leave a voicemail

Set “Forward to Voicemail”: Please check 4.11 Call Forwarding

5.9.2 Play a voicemail

When someone leaves a voice message on your voicemail, you can listen to the message directly.
Please check 4.4 Voicemail Management.
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(Figure 5-18)
Step 1: Select a voicemail and click “Play” button or double click the selected item to listen
toit.
Step 2: You can click “Stop” button or hang up the phone to stop the play.

5.10 Recording

5.10.1 Record Conversation

MyPBX Client provides recording function for users to record conversation.
During a call, you can click “Recording” button as Figure 5-19 shows; the system will start the
recording this conversation. Click “Stop” button when over; the system will auto finish the

recording when you hang up the call.
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(Figure 5-19)

5.10.2 Play Recording

All recordings will be stored on “Recording” listing, please refer to 4.5 Recording Management.
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(Figure 5-20)
(1) Select the item that you want to play, click “Play” button or double click on selected
item.
(2) You can click “Stop” button or hang up the phone to stop the play.

5.11 SMS

Right click the mouse and click “Send SMS” as Figure 5-21 shows, it will pop-up a window for
sending text as Figure 5-22 shows.

www.yeastar.com Page 66



\J
& :
70 Yeastar MyPBX Client Manual

(] mypex - 6041 =)
File View Contacts Tools Help
6047 (Online) -

\Calltask v 82 Confersnce
J Eda'mnns” Contacts ” I-ﬁstury” Voicemail ” Hﬂmrdlng|

2 eatensions online

© | Name | Bdno | Mobie e
:!:H_!Z: ‘i j .
3 @ Jack 041 Start chat...
3 @ el a9 Send SM5...
E @ —_— c028 Start call...
ﬂ -Z? Michael 602G Pick up call
S .Z? Jemy 6024 Refresh
& F leson 8020 Chat history...
S .J;? Jane 6025 e
3 .Z? Hamy 6021

5 ) Catherine s022

3 .f? Arthur 6027

8 > o 6ot

8 Iy e 6048 -
4 | i 3
13812345678 x|

(Figure 5-21)
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Trunks Country Code |China +86

(Figure 5-22)

Note: Before sending a SMS, please confirm that the correct configuration of SMS setting is made
on MyPBX to make Email to SMS work. Choose one GSM trunk and the corresponding country
code on the SMS window first, and send the SMS.
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6 Uninstall MyPBX Client

Uninstalling MyPBX Client will delete all your data, including contacts number, call log and
recorded voicemail on this PC. Before you uninstall MyPBX Client, make sure you have backed up
the data you need.

Method 1:
1. Go tothe Window’s Start menu and open MyPBX Client Uninstall

2. The next prompt screen will guide you to close the current running program first.

Choose “Next” to continue the uninstallation program.

%' Ininstalling EyPBX Client

Welcome to the MyPBX Client
Uninstallation!

This uninstall process will remove MyPB= Client from your
computer,

Click Cancel if vou do not want to remove this application.

Click Mext to continue the uninstall process,

| Mext = | [ Cancel

(Figure 6-1)

3. The Uninstallation progress will delete the MyPBX Client files from your computer. When the
uninstallation is complete, the Uninstall Finished screen will pop up. Click Finish button.
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MyPBX Client has been
successfully uninstalled!

Click 'Finish' to complete the uninstallation,

(Figure 6-2)

Method 2:

1. Gotothe Windows Start menu and open the Control Panel.

2. Go to the Add or Remove Programs, which will open a new screen with a list of software
programs installed on the computer. Scroll down to MyPBX Client and click Change/Remove
button.

[Finish]
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